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Tip Sheet 
 

 

Interactive Training Guides (ITG’s) 
What are ArchiCAD Interactive Training Guides? 

ArchiCAD 12 Interactive Training Guides are an easy way for users to acquaint themselves with ArchiCAD. The interactive 

training guides run within ArchiCAD and provide a smooth learning curve with their built-in movie guidance feature. After 

completing all modules of the guides, users will be able to find their way around ArchiCAD with confidence.  

ITG’s are available for download from the Internet or via DVD (BIM Learning Studio) from Graphisoft New Zealand at a 

minimal charge. ITG’s are available for both Windows and Macintosh platforms. 

The Interactive Training Guides available for ArchiCAD 12 are: 

 

• Experience BIM (Building Information Modelling) - Using the Frank Lloyd Wright designed Massaro House, this 

provides a conceptual overview of BIM (overview pages 4-7) 

• ArchiCAD Essentials - Designing and documenting an office building from scratch, this provides in-depth insight into the 

functions and working methods of a BIM application (overview pages 8-12) 

• Advanced Modelling - an introductory guide to advanced modelling techniques for creating complex forms and structures 

(overview pages 13-16) 

• Advanced Collaboration  -  an overview of workflows for project sharing and strategies for team working (pages 17-20) 

• Building Object Creation - an introduction to GDL object creation methods and techniques (overview pages 21-25) 

 

ITG Download via Internet:  

You can download all the Training Guides free-of-charge for both Macintosh and Windows 

platforms from http://www.graphisoft.com/products/archicad/training_guides/. Or from within 

ArchiCAD 12 simply click on the Help menu and click on ArchiCAD 12 Training Guide which 

takes you straight to Graphisoft’s ITG download web page. 

 

Note: We recommend a high speed internet connection for ITG downloading. If you do not have an internet 

connection or have a small data cap, you can purchase the BIM Learning Studio DVD from Graphisoft New Zealand. 

  

Installation on Windows: Once the ITG download is complete, just double click the executable (.exe) file and follow the 

installation wizard. 

 

Installation on MAC: Once the ITG download is complete double click on the .dmg file and follow the installation wizard. 

 

On both platforms, once the ITG is installed, there will be a new folder within the Graphisoft folder bearing the name of the 

ITG you have installed. 

 

In the example screen shot we have installed 

the ArchiCAD Modelling ITG. 

 

 

 

For your reference, watch the Introduction video by double-clicking on Introduction.mp4 in the ITG folder, or simply 

read the PDF manual. Each Chapter in the ITG has an ArchiCAD (.pla) file and a number of movies. In order to get started, 

simply open ArchiCAD 12 and click on the Browse button, then choose the .pla file from the relevant chapter folder. 
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If ArchiCAD is already open then go to the File menu and click on Open and Browse for the .pla from the relevant chapter. 

 

To play the movie guide, go to the Help 

Menu and click on ArchiCAD Movie Player.  

 

 

 

 

 

 

 

You can pause the movie after every couple of steps and repeat the 

steps in the .pla file.  To navigate between different movies within the 

Chapter, click on the arrow buttons as shown in the screen shot: 

 

ITG via BIM Learning Studio DVD: 

 

The Interactive Training Guides are part of the resources that make up the 4 gigabytes of content within the BIM Learning 

Studio. As well as the ITG’s, the BIM Learning Studio DVD includes: 

 

Free ArchiCAD software 30 day Trial version  

Online assessment  15 minute online multiple choice test 

Valuable rewards  If you complete an Online Assessment, your name is automatically entered into Graphisoft’s            

monthly draw to win a free ArchiCAD commercial license 

ArchiCAD Online  List of online forums and supplementary material websites 

Gallery   Pictures of ArchiCAD models created around the world 

 

Installation: Insert the BIM Learning Studio DVD into your computer.  

 

On a Windows machine, the start-up screen will automatically appear, if 

it does not, browse contents of the DVD and run the BimStudio.exe file.   

 

On a MAC machine, the BIM Learning Studio volume will be mounted on your desktop. 

Open this volume and double-click on ‘BIM Learning Studio’ icon. 

                                                              

 

 

 

 

From the BIM Learning Studio start page, click on the BIM Learning Studio tab, then choose the ITG you wish to install; 

the temporary installation files will start extracting. 
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On a Mac a new volume will be mounted with the name of the ITG, open 

this and double-click on the ‘ITG named’ file, and an installation wizard 

will appear. 

On a PC the Installation wizard just appears.  On both platforms simply 

follow the instructions of the installation wizard. 

 

 

 

 

 

Once the ITG is installed, there will be a new folder in the Graphisoft folder bearing the name of the ITG you have installed. 

In the example screen shot below we have installed the ArchiCAD Modelling ITG. 

 

For your reference, watch the Introduction video by double-clicking on Introduction.mp4 in the ITG folder, or simply 

read the PDF manual. Each Chapter in the ITG has an ArchiCAD (.pla) file and a number of movies. In order to get started, 

simply start ArchiCAD 12 and click on the Browse button, then choose the .pla file from the relevant chapter folder. 

 

If ArchiCAD is already open then go to the File menu and click on Open and Browse for the .pla from the relevant Chapter. 

 

To play the movie go to the Help menu 

and click on ArchiCAD Movie Player.  

 

 

 

 

 

 

 

 

 

You can pause the movie after every couple of steps and repeat the 

steps in the .pla file.  To navigate between different movies within the 

Chapter, click on the arrow buttons as shown in the screen shot: 
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BIM Experience Kit 

Overview: BIM stands for Building Information Modelling. BIM kit 

provides you with step by step instructions to build the Massaro House, using 

ArchiCAD’s BIM architectural environment. The Massaro House project used 

for the BIM Experience Kit is unique- a Frank Lloyd Wright design that was 

built decades after he created his original drawings. It's a great focus for this 

hands-on experience that allows 2D CAD users to complete an entire building 

using 3D BIM processes. 

 

Download Size (International English-metric):  

MAC OSX - 565MB 

Windows   - 595 MB 

Ideal time for completion: 2-3 Hours 

 

Chapter 01- Introducing the Project, has 3 exercise movies (Steps) 

 

Step 1: Introducing the Building     Time Duration: 1 min 32 sec 

• The Massaro House designed by Frank Lloyd Wright     

 

Step 2: Introducing the ArchiCAD BIM environment    Time Duration: 1 min 50 sec 

• ArchiCAD’s integrated design, documentation environment   

 

Step 3: Navigating in the Project      Time Duration: 6min 25sec 

• Trace and Reference, Favourites palettes 

• Navigating between different preset views  

• Using Zoom, Pan and Scroll functions 

• Interactive Window list 

 

Chapter 02- Creating Walls, has 6 exercise movies (Steps)    

 

Step 1: Creating exterior walls      Time Duration: 7min 15sec 

• Creating a new Independent Work sheet 

• External drawings  

• Trace and Reference    

• Exploding the DWG 

 

Step 2: Creating Polygonal Walls     Time Duration: 1min 13sec 

• Magic Wand  

 

 

  

Step 3: Creating Parapet Walls      Time Duration: 1min 27sec 

• Drawing the parapet walls  

• Display Order 

 

Step 4: Creating Partition Walls     Time Duration: 1min 01sec 

• Drawing Partition walls  

 

Step 5: Creating above-parapet Walls    Time Duration: 55sec 

• Creating the parapet walls 

 

Step 6: Modifying Wall heights     Time Duration: 1min 55sec 

• Marquee tool     
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•  Trace and Reference  

Chapter 03- Creating Floors and Roofs, has 7 exercise movies (Steps)  

 

Step 1: Creating Floors      Time Duration: 1min 37sec 

•  Creating all horizontal structures 

•  Creating the Slabs using the magic wand  

 

Step 2: Creating Roofs      Time Duration: 1min 33sec 

• Creating flat Roofs using Slab tool 

• Making holes in Slabs 

 

Step 3: Creating above-parapet Walls    Time Duration: 55sec 

• Creating parapet walls 

• View the model in 3D 

 

Step 4: Creating Skylight roofs      Time Duration: 32sec 

• Creating the Skylight roofs. 

 

Step 5: Creating Skylight Glasses     Time Duration: 59sec 

• Magic wand  

 

Step 6: Creating Skylight roof holes     Time Duration: 1min 13sec 

• Cutting holes into the roof. 

 

Step 7: Creating fascias      Time Duration: 1min 19sec 

• Creating fascias 

 

Chapter 04- Placing Doors, Windows and Skylights, has 5 exercise movies (Steps)  

 

Step 1: Placing doors       Time Duration: 1min 13sec 

• Door settings and all its parameters 

• Preview options 

• Placing doors on plan 

 

Step 2: Multiplying doors      Time Duration: 1min 49sec 

• Multiplying doors 

 

Step 3: Placing Windows      Time Duration: 1min 06sec 

• Placing a window , cursor orientation  

 

Step 4: Multiplying Windows      Time Duration: 3min 47sec 

• Multiplying windows in plan/elevation view 

 

Step 5: Placing skylight wall windows    Time Duration: 1min 11sec 

• Placing some more windows in the wall 

 

Chapter 05- Creating the Model Terrain, has 4 exercise movies (Steps)  

 

Step 1: Creating the Site       Time Duration: 5min 25sec 

• Creating a new independent worksheet  

• Import a DWG as an external drawing and explode it into current view 

• Magic wand the terrain 
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• Elevate mesh points 

• Adding nodes to the contour lines  

 

Step 2: Creating the lake      Time Duration: 29sec 

• Magic wanding the mesh 

 

Step 3: Creating rocks and the landing    Time Duration: 1min 27sec 

• Space click(Magic wand) on the rocks 

• Altering the rocks height  

 

Step 4: Creating the house outline     Time Duration: 1min 15sec 

• Creating the mesh  

• View the model in 3D 

 

Chapter 06-Creating Stair and modifying the model in 3D, has 3 exercise movies (Steps)  

 

Step 1: Creating stair       Time Duration: 2min 54sec 

• Stair selection settings, different types of stairs 

• Display order  

 

Step 2: Modifying model in 3D     Time Duration: 4min 59sec 

• Solid Element Operations (SEO) 

• Performing Solid Element Operations (SEO) 

• Modifying the slab materials 

 

Step 3: Placing trees      Time Duration: 1min 35sec 

• Gravity to Mesh option 

• Placing the trees on the mesh  

• View the model in 3D 

 

Chapter 07-Creating Furniture and Interior elevations, has 3 exercise movies (Steps)  

 

Step 1: Placing kitchen furniture      Time Duration: 1min 55sec 

• Placing objects  

• Turning ON the hidden layer 

 

Step 2: Creating Interior elevations     Time Duration: 51sec 

• Interior Elevation tool  

• Placing Interior Elevations at the correct depth 

 

Step 3: Editing the model in the Interior elevations window  Time Duration: 2min 05sec 

• Opening up the Interior Elevations view  

• Performing Solid Element Operation  

• Changing the window style in the Interior Elevation 

 

Chapter 08-Creating Documentation, has 7 exercise movies (Steps) 

 

 

Step 1: Placing Zones      Time Duration: 2min 43sec 

• Zone tool  

• Adding more parameters under Zone stamp 
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Step 2: Dimensioning the Building     Time Duration: 2min 07sec 

• Dimension tool 

• Using Automatic Dimensioning feature 

• Placing Automatic Dimensions for all exterior walls 

 

Step 3: Dimensioning Sections Time Duration: 51sec 

• Placing Level Dimensions in the elevation view 

 

Step 4: Fine tuning the model      Time Duration: 2min 15sec 

• Cleaning up intersections 

• Performing few more Solid Element Operations 

 

Step 5: Referencing other Sections     Time Duration: 1min 21sec 

• Placing a section marker 

• Linked markers and referencing them 

 

Step 6: Creating worksheets and details    Time Duration: 2min 17sec 

• Placing external drawing in the detail window 

• Placing a worksheet marker 

• Placing a detail marker 

 

Step 7: 3D Documentation      Time Duration: 4min 25sec 

• Capturing 3D documentation info 

• Adding some dimensions in 3D documentation window 

• Adding text, labels in the 3D documentation window 

 

Chapter 09-Creating Photo Rendering, has 1 exercise movie 

 

Step1: Creating Photo rendering     Time Duration: 2min 23sec 

• Generating a Sketch render 

• Using Lightworks render engine 

 

Chapter 10-Creating Layouts and Publishing the project, has 4 exercise movies (Steps) 

 

Step 1: Creating layouts       Time Duration: 3min 38sec 

• Layouts and master layout settings 

• Creating new master layout 

• Inserting ‘Auto text’ on the master layout 

 

Step 2: Placing views on the layouts     Time Duration: 4min 51sec 

• How to bring up the organiser 

• Dragging the views on to the layout sheet 

• Placing 3D views, section/elevations on to the layouts 

 

Step 3: Creating publisher sets      Time Duration: 1min 20sec 

• Making a new publisher set 

• Setting publishing properties 

 

Step 4: Publishing        Time Duration: 2min 28sec 

• Setting the publishing format 

Merging multiple PDF’s to single PDF  

Congratulations on successful completion of BIM Experience!! 
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ArchiCAD Essentials 

Overview: The new ArchiCAD Essentials ITG guides you through the 

creation of a modern office building built in Graphisoft Park, Budapest, 

Hungary. New ArchiCAD users will be introduced to the core architectural 

design, design-development and documentation concepts and techniques of 

ArchiCAD, and will be ready to implement these instantly in their everyday 

design work. Experienced users will also find this guide useful by learning 

about the new features of ArchiCAD 12 in action. 

 

Download Size (International English-metric):  

MAC OSX - 763MB 

Windows   - 794 MB 

Ideal time for completion:  12-13 Hours 

 

Chapter 01- Introducing the Project has 5 exercise movies (Steps) 

 

Step1: Introduction       Time Duration: 6 min 25 sec 

• Screen Resolution recommended -1280X960 

• Resizing the movie player window 

• Pausing the video and repeating the steps 

• We recommend the chapter to be done sequentially  

 

Step 2: Introduction to the Building     Time Duration: 1 min 27 sec 

• Location of the project  

• History of Budapest 

• Designing Microsoft Hungary Head Quarters 

 

Step 3: Introduction to ArchiCAD Environment   Time Duration: 4 min 20 sec 

• Tool box, Navigator 

• Project Map, View Map, Layout Book, Publisher 

• Bringing up the Favourites palette 

 

Step 4: Navigating in the Project     Time Duration: 5 min 50 sec 

• View Map navigation 

• Pan mode 

• Zoom IN/OUT 

• Orbit in 3D window 

• Combination of Zoom, Pan, Orbiting 

 

Step 5: Working with Stories     Time Duration: 2 min 43 sec 

• Story Settings 

• Setting up stories 

• Going Up/Down a story 

 

Chapter 02- Creating Masses and the Building Structures, has 5 exercise movies (Steps)  

 

Step 1: Creating the masses of the Building    Time Duration: 5 min 10 sec 

• Creating main Masses of the building-using Zone tool 

 

Step 2: Creating the Structural Grid     Time Duration: 11 min 15 sec 

• Grid system Settings 
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• Grid Element Settings 

• Navigating to different stories 

 

Step 3: Creating Exterior Walls     Time Duration: 11 min 12 sec 

• Creating Complex Profiles 

• Turning the Wall reference line ON/OFF 

• Dragging and Extending Walls 

 

Step 4: Editing Columns      Time Duration: 06 min 39 sec 

• Deleting Columns  

• Drag a Copy(Using Guide Lines) 

• Marquee tool 

 

Step 5: Creating Slabs      Time Duration: 10 min 41 sec 

• Offsetting Slabs 

• Inserting new nodes 

• Drag, Rotate, Multiplying Slabs 

• Adjusting 

• Trimming walls 

 

Chapter 03- Creating Curtain Walls and Exterior Openings, has 5 exercise movies (Steps) 

 

Step 1: Creating Openings       Time Duration: 3min 30sec 

• Adding empty window openings 

• Going UP/Down stories 

 

Step 2: Creating window Curtain Walls     Time Duration: 3min 04sec 

• Curtain Walls settings and Dialog boxes 

• Drawing a Curtain wall 

 

Step 3: Creating Curtain Walls      Time Duration: 13min 30sec 

• Placing Curtain Walls 

• Editing Curtain Walls in 3D 

• Navigating in 3D window 

• Deleting frames from existing Curtain wall 

 

Step 4: Exploring 3D view options     Time Duration: 2min 22sec 

• Difference between Open GL and Internal 3D engine 

• Vectorial 3D hatching, Sun shadows in Internal 3D engine 

 

Step 5: Placing external Doors      Time Duration: 3min 42sec 

• Placing doors on plan 

• Multiplying doors in 3D window 

• Elevating doors in 3D window 

 

Chapter 04- Creating Interior Walls and Openings, has 3 exercise movies (Steps) 

 

Step 1: Creating Interior Structural Walls     Time Duration: 16min 51sec 

• Suspend groups 

• Snap points 

• Multiply doors in 3D 

• Placing some Stairs  
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Step 2: Creating Interior partition walls    Time Duration: 4min 14sec 

• Creating some more walls 

• Drag multiple copies  

 

Step 3: Placing Interior door openings    Time Duration: 7min 21sec 

• Placing some doors on the plan 

• Snap grid and Nudge feature 

 

Chapter 05- Solid Element Operation, creating Objects and Terrains has 3 exercise movies (Steps) 

 

Step 1: Solid Element Operation (SEO)    Time Duration: 7min 33sec 

• SEO dialog box 

• Cutting holes in the slabs 

• Filtering elements in 3D window 

 

Step 2: Placing objects      Time Duration: 15min 10sec 

• Special snap points 

• Placing columns, beams 

• Placing Railing and Ramp objects 

• Turning OFF True Line Weight 

 

Step 3: Creating the Terrains     Time Duration: 4min 05sec 

• Creating a mesh 

• Cutting holes in the mesh 

• Placing Ramp objects 

 

Chapter 06- Creating Zones, Sections and Elevations, has 3 exercise movies (Steps) 

 

Step 1: Creating the Zones      Time Duration: 7min 21sec 

• Zone settings, Zone stamps 

• Placing Zones on the plan 

• Display order 

• Updating Zones 

 

Step 2: Creating Sections/Elevations    Time Duration: 17min 21sec 

• Section settings dialog boxes 

• Placing a section line 

• Break section/elevation line 

• Placing elevation 

• Mark Distant Area, Story level lines 

• Grid Display 

• SEO to correct intersections 

 

Step 3: Creating Interior Elevations      Time Duration: 3min 26sec 

• Placing  Interior Elevations 

 

Chapter 07- Creating Dimensions, Schedules and Partial Structure, has 3 exercise movies (Steps) 

 

Step 1: Creating   Dimensions     Time Duration: 8min 48sec 

• Placing Linear Dimensions 

• Placing Automatic Dimensions 
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Step 2: Creating Schedules      Time Duration: 5min 44sec  

• Door schedules 

• Schedule and format options 

 

Step 3: Partial structure Display      Time Duration: 9min 07sec 

• Complex profiles 

• Partial Structure display dialog 

• Clone folders 

• Publishing to DWG format 

 

Chapter 08- Creating Drawings, Worksheets and 3D Documents, has 4 exercise movies (Steps) 

 

Step 1: Importing Details      Time Duration: 2min 52sec 

• Creating Independent Detail 

• Importing External DWG into ArchiCAD  

 

Step 2: Using Trace Reference     Time Duration: 7min 50sec 

• Trace and reference palette 

• Creating Independent Worksheet 

• Virtual compare-splitters 

 

Step 3: Creating 3D Document     Time Duration: 12min 09sec 

• 3D documentation settings dialog 

• Creating a new 3D document view 

• Dimensioning in 3D documentation window 

 

Step 4: Cross referencing Markers     Time Duration: 6min 25sec 

• Section selection settings 

• Linked and Unlinked Markers 

 

Chapter 09- Creating Presentation Images, has 2 exercise movies (Steps) 

 

Step 1: Creating Fills       Time Duration: 13min 08sec 

• Fill selection settings 

• Translucent fills 

• Make new Fill type 

• Display order  

  

Step 2: Presentation Renderings       Time Duration: 6min 56sec 

• 3D window settings 

• Photo render settings 

• Lightworks, Sketch rendering engine 

 

Chapter 10- Layouting and Publishing the Project, has 3 exercise movies (Steps) 

 

Step 1: Creating Layouts       Time Duration: 12min 40sec 

• Creating master layouts  

• Inserting Auto text 

• Placing figures on the master layout 

• Layout settings Dialog box 
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Step 2: Placing Views on the Layout     Time Duration: 7min 09sec 

• Organizer 

• Placing views onto the layout sheets 

• Master Layout settings-Grid setup 

  

Step 3: Publishing the project      Time Duration: 4min 48sec 

• Publisher set 

• Publishing properties 

• Format 

 

Congratulations on successful completion of ArchiCAD Essentials ITG! 
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Modeling 

Overview: The Modeling Training Guide covers the following topics: 

Generic modeling: basic volumes and shapes; Architectural modeling: 

structural grids, terrains, slanted- and composite walls, columns, 

beams, stairs and roofs; Special openings, Special constructions. 

 

Download Size (International English-metric):  

MAC OSX – 633 MB 

Windows   - 663 MB  

Ideal time for completion: 6-7 Hours 

 

Chapter 1- Architectural Modeling: Terrains, has 4 exercise movies (Steps) 

 

Step 1: Customising the Mesh Parameters    Time Duration: 1min 41sec 

• Mesh selection settings dialog box 

 

Step 2: Creating Mesh from External 2D drawing   Time Duration: 4min 47sec 

• Importing DWG file into ArchiCAD 

• Creating contour lines 

• Setting up Mesh point Height 

 

Step 3: Creating a Plateau Slab on the Terrain   Time Duration: 1min 41sec 

• Putting a slab on the mesh 

• Magic wand  

 

Step 4: Adding a sloping road to the Project    Time Duration: 2min 58sec 

• Cutting a hole in the mesh  

• View the 3D model in Internal Engine-wireframe mode 

 

Chapter 2- Using Solid Element Operations (SEO), has 4 exercise movies (Steps) 

 

Step 1: Creating 3D Form of a Church    Time Duration: 3min   15sec 

• Placing some Basic shape objects-Elementary geometric shapes 

 

Step 2: Adding the Choir and Aisles Volume    Time Duration: 2min   07sec 

• Placing multiple roofs-hipped, plain 

 

Step 3: Creating a Bell Tower     Time Duration: 5min   22sec 

• Finding library parts 

• Performing Solid Element Operation 

• Saving a new view 

 

Step 4: Completing the 3D Form of the Church   Time Duration: 5min   43sec 

• Using Multiply, Elevate options  

• Performing some more SEO’s 

 

Chapter 3- Architectural Modeling: Structural Grid, has 3 exercise movies (Steps) 

 

Step 1: Creating a New Structural Grid Column, Beam & Dimensions  

• Grid systems dialog box settings     Time Duration: 3min 42sec 

• Placing Grid Element 
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• Adding columns at every intersection 

 

Step 2: Adding a second Structural Grid    Time Duration: 1min 52sec 

• Grid Elements settings dialog box 

 

Step 3: Modifying the Structural Grid’s Elements   Time Duration: 3min 17sec 

• Rotating grid element 

• Locking the layer 

 

Chapter 4- Architectural Modeling: Columns, Beams and Complex Profiles, has 7 movies (Steps) 

 

Step 1: Modifying the Attributes of Columns    Time Duration: 2min   36sec 

• Deleting some columns 

• Eye dropper-Pick up and Inject parameters 

 

Step 2: Placing Circular Slanted Columns    Time Duration: 1min   19sec 

• Column settings dialog box info 

• Setting up the slant angle 

  

Step 3: Creating New Complex Profiles for Construction Elements  

• Creating a new Complex Profile and saving it   Time Duration: 2min 06sec 

 

Step 4: Placing Profiled Columns     Time Duration: 1min 44sec 

• Choosing Complex Profile option from Column settings 

 

Step 5: Creating Inclined Beams and Defining Intersection Priority of Beams & Columns  

• Placing new Beam on plan     Time Duration: 3min 09sec 

• Setting up Beam priority 

 

Step 6: Defining Holes in the Beam     Time Duration: 2min 55sec 

• Inserting holes in the beam 

 

Step 7: Adding an ArchiCAD Object to the Structure   Time Duration: 3min 41sec 

• Placing some beams vertically using guide lines 

• Drag multiple copies of beams 

 

Chapter 5- Architectural Modeling: Walls-Slanted Walls/Composite Walls, has 6 movies (Steps) 

 

Step 1: Creating and Editing Straight and Slanted Wall  Time Duration: 4min 01sec 

• Placing a slanted wall 

• Stretching the slanted wall in 3D window  

 

Step 2: Wall Priorities and Layer Intersection-Group Number Functionality  

Time Duration: 1min   19sec 

• Layer settings dialog box info-turning the layers ON/OFF 

 

Step 3: Creating new Composite Structure for Walls   Time Duration: 2min   28sec 

• Creating a new Wall composite Structure  

• Drag multiple copies of beams 

 

Step 4: Using the Modify Wall Command    Time Duration: 3min   08sec 

• Adding ‘Modify Wall’ option under Design menu using Work environment dialog box 
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Step 5: Drawing a Double-Slanted Wall    Time Duration: 4min   02sec 

• Creating  Double-slanted icon in geometry and positioning 

 

Step 6: Creating and Editing a Profiled Wall    Time Duration: 3min   38sec 

• Creating a new Complex profiled wall 

 

Chapter 6- Architectural Modeling: Roofs, has 5 exercise movies (Steps) 

 

Step 1: Creating a Simple Roof in 3D    Time Duration: 3min   23sec 

• Placing roof in 3D window 

 

Step 2: Trimming Walls and Columns to the Roof   Time Duration: 3min   48sec 

• Performing ‘Trim to Roof’ operation on Columns and Walls 

 

Step 3: Creating a Polyroof      Time Duration: 2min   03sec 

• Creating a Polyroof using polygonal geometry method  

 

Step 4: Creating a New Barrel-Vaulted Roof on the Floor Plan Time Duration: 2min   29sec 

• Choosing Barrel –Vaulted geometry method 

• Placing a Barrel-Vaulted Roof  

 

Step 5: Constructing an Irregular Barrel-Vaulted Roof in 3D  Time Duration: 1min   54sec 

• Explains how to place a Barrel-Vaulted Roof in 3D window 

   

Chapter 7- Special Constructions: Special Openings-skylights/Corner Windows, has 5 (Steps) 

 

Step 1: Creating Special Windows     Time Duration: 3min   54sec 

• Placing Special window 12   

 

Step 2: Customising and Placing a Storefront Door   Time Duration: 2min   16sec 

• Placing Storefront door on the plan 

 

Step 3: Creating an Empty Opening     Time Duration: 2min   22sec 

• Placing multiple Empty Opening windows 

 

Step 4: Placing a Skylight Object     Time Duration: 3min   31sec 

• Placing Skylight top hung object on the plan  

 

Step 5: Adding Entrances to the Project    Time Duration: 1min   41sec 

• Placing Custom entrance door on the plan 

   

Chapter 8- Architectural Modeling: Stair, has 4 exercise movies (Steps) 

 

Step 1: Adjusting and Placing an Existing Stair Object  Time Duration: 2min   40sec 

• Placing Stair Spiral Object on the plan 

• Cutting a circular hole in the slab 

 

Step 2: Creating a New Stair Case     Time Duration: 2min   43sec 

• Creating New Stair Case option  

 

Step 3: Creating Stair with the Profile Manager   Time Duration: 2min   09sec 

• Creating new complex profile 



 
Interactive Training Guides 

© Graphisoft New Zealand  16 

Step 4: Create Stair using Selection  Time Duration: 4min   02sec 

• Creating the Stair using Stair Maker 

 

Chapter 9- Special Constructions-TrussMaker, has 2 exercise movies (Steps) 

 

Step 1: Creating a Truss from Rolled Steel Profiles   Time Duration: 6min   01sec 

• Select the Truss element and use the Trussmaker command available Design>Design extras>Trussmaker 

 

Step 2: Terminating the Building Structure     Time Duration: 1min   52sec 

• Performing Solid Element Operations 

 

Chapter 10- Special Constructions-RoofMaker, has 2 exercise movies (Steps) 

 

Step 1: Using the Roof Wizard Settings     Time Duration: 3min   11sec 

• Go to Design>Design extras>Roofmaker and bring up the Roof wizard command 

• Edit the parameters in Roof Wizard Settings dialog box 

 

Step 2: Modifying Elements of the Roof Structure   Time Duration: 2min 52sec 

• Add some Purlins to the roof using the Roofmaker  

 

Congratulations on successful completion of Modeling ITG!! 
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Collaboration 

Overview: This ITG module gives an overview of workflows for project 

sharing and strategies for team working. 

 

Download Size (International English-metric):  

MAC OSX –673 MB 

Windows -703 MB  

Ideal time for completion: 6-7 Hours 

 

Chapter 01-DWG, DXF export and import, has 3 exercise movies (Steps) 

 

Step 1: Setting up DWG, DXF Translators    Time Duration: 5min 08sec 

• Translator set up dialog 

• Different types of translators 

 

Step 2: Collaboration using DWG, DXF files    Time Duration: 7min 41sec 

• Saving the view in DWG format 

• Exporting the DWG to AutoCAD 

• Smart Merge Options  

• Importing the finished plan from AutoCAD to ArchiCAD 

• Merge file 

 

Step 3: Creating a new ArchiCAD object from a DXF file   Time Duration: 5min 44sec 

• Importing 3D DXF files  

• Saving as a .gsm object 

 

Chapter 02-PDF export and import, has 2 exercise movies (Steps) 

 

Step 1: Adding external PDF documents to the Layout Book  Time Duration: 3min 24sec 

• Place External Drawing  

• Drawing Manager 

 

Step 2: Publishing the Layout Book as a PDF document set   Time Duration: 3min 57sec 

• Creating new Publisher set 

• Merge to one PDF 

• Publishing to PDF format 

 

Chapter 03-Universal 3D support, has 3 exercise movies (Steps) 

 

Step 1: Creating a simple computer workstation design   Time Duration: 7min 15sec 

• Finding library part 

• Gravity tool 

 

Step 2: Placing the design views on layouts     Time Duration: 3min 10sec 

• Placing the drawing on the layout 

• Saving the 3D view in .U3D file format 

 

Step 3: Publishing a 3D PDF from ArchiCAD    Time Duration: 5min 39sec 

• Publishing U3D PDF 

• Rotate, Pan, Zoom in Adobe Acrobat 
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Chapter 04-External reference files (XREFs), has 3 exercise movies (Steps) 

 

Step 1: Attaching XREFs to the project    Time Duration: 4min 19sec 

• XREF settings dialog box 

• Attaching XREF file 

• Layers 

 

Step 2: Managing XREFs      Time Duration: 4min 13sec 

• XREF Manager dialog box 

• Attaching XREF file 

• Detaching XREF 

 

Step 3: Nested External Reference Files    Time Duration: 5min 25sec 

• XREF management 

 

Chapter 05-Project Hotlinks, has 3 exercise movies (Steps) 

 

Step 1: Hotlinked drawings in the Model View   Time Duration: 3min 57sec 

• Placing DWG’s as External Drawings  

• Placing PDF’s as External Drawings  

 

Step 2: Hotlinked drawings in the Layout Books   Time Duration: 7min 26sec 

• Placing External Drawings on the Layout Book 

• Drawing title 

 

Step 3: Updating and managing Project Hotlinks   Time Duration: 3min 00sec 

• Drawing manager dialog box 

• Updating the drawings  

 

Chapter 06-Hotlinked Modules, has 5 exercise movies (Steps) 

 

Step 1: Relocating hotlinked modules    Time Duration: 6min 12sec 

• Hotlink manager dialog box 

 

Step 2: Getting familiar with hotlinked modules   Time Duration: 3min 25sec 

• Hotlinks Sources 

• Editing module in separate instance of ArchiCAD 

 

Note: There is no Video for Step 3 

 

Step 4: Updating hotlink modules     Time Duration: 1min 47sec 

• Updating Hotlinks Sources 

 

Step 5: Adding new hotlinked modules to the project  Time Duration: 5min 27sec 

• Adding more modules 

• Drag multiple copies 

 

Step 6: Managing hotlinked modules     Time Duration: 2min 24sec 

• Relinking the modules 

• Hotlink Manager- hierarchy structure 
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Chapter 07-Project Mark-up, has 2 exercise movies (Steps) 

 

Step 1: Creating a new Mark-Up entry    Time Duration: 5min 21sec 

• Creating new Mark-Up styles 

• Mark-Up tools settings 

• Redline cloud 

 

Step 2: Managing Mark-Up entries Time Duration: 6min 47sec 

• Show/Hide –Tag text 

• Highlight elements 

• Remove corrections 

• Zoom and Select 

 

Chapter 08-Project Reviewer, has 3 exercise movies (Steps) 

 

Step 1: Publishing a design documentation set to the Internet  Time Duration: 4min 45sec 

• Publishing methods-Upload to internet 

• Sending an email to the client  

 

Step 2: Reviewing the design set using an Internet browser   Time Duration: 7min 48sec 

• Graphisoft project reviewer 

• Redlining and correction  

 

Step 3: Working with external DWF mark-up files in ArchiCAD  Time Duration: 3min 13sec 

• New Mark-up entry 

• Reviewing the corrections 

 

Chapter 09-TeamWork, has 5 exercise movies (Steps) 

 

Step 1: Setting up a Teamwork project     Time Duration: 4min 53sec 

• Assigning user name and passwords 

• Creating a shared ArchiCAD design project (.plp) 

• Backup Options 

 

Step 2: Signing–In to Teamwork project    Time Duration: 5min 08sec 

• Signing in to Teamwork project 

• Teamwork Draft file (plc) 

• Send and Receive changes  

 

Step 3: Reserving Workspaces in Teamwork project   Time Duration: 4min 02sec 

• Work space allocation 

• Send and Receive changes  

Step 4: Working in Teamwork environment    Time Duration: 7min 30sec 

• Project Sharing Info 

• Mark-Up tool corrections 

 

Step 5: Collaborating in TeamWork environment    Time Duration: 3min 22sec 

• Get Mark-Up Entries 

• Making changes 
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Chapter 10-IFC: Industry Foundation Classes, has 3 exercise movies (Steps) 

 

Step 1: Working with IFC TreeView     Time Duration: 7min 15sec 

• IFC entry in Tool settings dialog box 

• IFC  TreeView dialog box 

 

Step 2: Exporting an ArchiCAD project in IFC format   Time Duration: 7min 42sec 

• Editing composite structures 

• Partial structure display 

• IFC 2x Edition 3 Options dialog box 

 

Step 3: Importing an IFC database to ArchiCAD   Time Duration: 2min 23sec 

• Importing IFC 2X3 file into ArchiCAD 

 

Congratulations on successful completion of Collaboration ITG!! 
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Building Objects Creation 

Overview: The Building Objects Creation Training Guide covers basic and 

advanced GDL scripting. 

Saving 2D symbols and 3D models as GDL objects; 

 

Download Size (International English-metric):  

MAC OSX – 746 MB 

Windows   - 776 MB  

Ideal time for completion: 10-12 Hours 

 

Chapter 01-Saving 2D symbols from the Floor Plan, has 5 exercise movies (Steps) 

 

Step 1: Creating the Symbol      Time Duration: 1min 24sec 

• Creating a 2D North Point symbol using Lines, Fills, Circle tools 

 

Step 2: Saving the Object      Time Duration:  53sec 

• Saving as a .gsm object 

 

Step 3: Checking the Result      Time Duration: 1min 51sec 

• Placing the object on the plan 

 

Step 4: Final Touches      Time Duration: 2min 35sec 

• Adding comments to the object 

• Opening the GDL Master window 

 

Step 3: Using the 2D symbol View      Time Duration: 3min 15sec 

• GDL 2D scripting window 

• Adding some hotspots to the object 

 

Chapter 02-Saving 3D symbols from the Floor Plan as GDL objects, has 4 exercise movies (Steps) 

 

Step 1: Overview       Time Duration: 1min 16sec 

• Info regarding Alvar Alto’s Double Coffee Table 

 

Step 2: Modelling       Time Duration: 5min 03sec 

• Drawing the Coffee Table in 2D using Slab, Wall, Column tools 

 

Step 3: Creating the GDL Object     Time Duration: 2min 32sec 

• Check the 2D model in 3D window 

• Save 3D model as .gsm object 

 

Step 4: Editing the GDL Object     Time Duration: 7min 05sec 

• Open Object-2D symbol editing  

• Preview Picture for a library object 

 

Chapter 03-Adding Material parameters to library parts, has 5 exercise movies (Steps) 

 

Step 1: Overview       Time Duration: 36sec 

• Info regarding Alvar Alto’s PAIMIO Chair 
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Step 2: Modelling       Time Duration: 7min 01sec 

• Drawing the PAIMIO chair using Slab tool 

• Creating Frame, Bracing of the chair 

 

Step 3: Creating the GDL Object     Time Duration: 3min 53sec 

• Check the 2D model in 3D window 

• 3D Projection settings 

• Save 3D model as .gsm object-Editable GDL script 

 

Step 4: Editing the GDL Object     Time Duration: 6min 07sec 

• Open Object-2D symbol editing  

• Adding hotspots to the object 

 

Step 5: Adding Material Parameters     Time Duration: 6min 35sec 

• Open Object-2D symbol editing  

• 3D GDL scripting 

 

Chapter 04- Auto saving rectangular doors. Creating Custom Door Panels, has 5 movies (Steps) 

 

Step 1: Overview       Time Duration: 37sec 

• Info regarding Prairie door 

 

Step 2: Modelling       Time Duration: 4min 12sec 

• Creating the door using Slab tool 

• Cutting hole in the slab 

 

Step 3: Creating the GDL Object     Time Duration: 2min 58sec 

• Save 3D model as .gsm object  

 

Step 4: Editing the GDL Object     Time Duration: 2min 26sec 

• GDL  -2D symbol editing window 

• Saving the changes 

 

Step 5: Creating Custom Door Panels    Time Duration: 5min 

• Loading libraries 

• Check the custom door panel in 3D window 

• Modifying the door opening angle 

 

Chapter 05- Auto saving Non-rectangular Windows, has 6 exercise movies (Steps) 

 

Step 1: Overview       Time Duration: 1 min 09sec 

• Info regarding Gothic Rose Window 

 

Step 2: Modelling       Time Duration: 5min 15sec 

• Modelling Window Mullions 

• Cutting holes in the Slab 

 

Step 3: Creating the GDL Object     Time Duration: 3 min 15sec 

• Saving 3D model as .gsm object 

• Place the Rose window on the plan 
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Step 4: Enhancing the 2D Symbol     Time Duration: 1 min 47sec 

• Creating new 2D symbol for the Ross window object 

 

Step 5: Adding Material Parameters     Time Duration: 2 min 45sec 

• GDL window–hiding some parameters 

• Editing 3D script 

 

Step 6: Make a Preview Picture with Lightworks    Time Duration: 4 min 29sec 

• Preview picture option in GDL window 

• PhotoRendering settings 

 

Chapter 06- Basics of GDL scripting, has 8 exercise movies (Steps) 

  

Step 1: Overview       Time Duration: 4 min 02sec 

• Info regarding Pedestal table  

• Subtype in the GDL master window 

 

Step 2: Creating Parameters      Time Duration: 2 min 38sec 

• Setting  ZZYZX default variable 

 

Step 3: Creating the 3D Geometry      Time Duration: 8 min 06sec 

• 3D view in GDL master window 

• G(Global),L(Local) string 

• AC12 GDL reference guide 

• 3D script window 

 

Step 4: Assigning Materials      Time Duration: 2 min 23sec 

• Syntax code from GDL reference guide 

  

Step 5: Creating Value Lists For Parameters    Time Duration: 1 min 56sec 

• Values script from GDL reference guide 

 

Step 6: Checking the 3D model     Time Duration: 33sec 

• Modifying the ZZYZX parameter 

 

Step 7: Creating the 2D of the object    Time Duration: 1 min 35sec 

• Circle2 command script from the GDL reference guide 

 

Step 8: Placing and working with the Object    Time Duration: 4 min 36sec 

• Saving the Object in appropriate location 

• Editing the Object in 3D window 

 

Chapter 07- Basics of GDL scripting- Part ll, has 4 exercise movies (Steps) 

 

Step 1: Overview       Time Duration: 1 min 36sec 

• Info regarding Extension Table 

 

Step 2: Creating the Parameters     Time Duration: 6 min 26sec 

• Saving a new .gsm object 

• Organising 2D/3D parameters  
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Step 3: Creating the Master Script     Time Duration: 3 min 39sec 

• Defining variables for 2D/3D script 

• IF<Cond> Then< Cond> command 

 

Step 4: Creating the 3D Script     Time Duration: 15 min 55sec 

• PRISM_ command syntax from GDL reference guide 

• 3D scripting  

• END command 

 

Chapter 08- Basics of GDL scripting- Part lll, has 3 exercise movies (Steps) 

 

Step 1: Overview        Time Duration: 8 min 38sec 

• Comment/Uncomment  lines  

• Indent button 

 

Step 2: Creating the Legs       Time Duration: 8 min 52sec 

• Setting the attributes in the master script 

• ADD x,y,z command 

 

Step 3: Creating the 2D script     Time Duration: 8 min 14sec 

• Fill and Pen command 

• IF<Cond> Then<cond> Else<cond> 

• Show insert parameter 

• HOTSPOT2 command 

 

Chapter 09- Advanced GDL scripting- Part lll, has 6 exercise movies (Steps) 

 

Step 1: Overview        Time Duration: 1 min 43sec 

• Creating a door’s  pentagon upper edges  

• Indent button 

 

Step 2: Creating the Parameters     Time Duration: 4min 23sec 

• Subtype Hierarchy 

• Saving the Door as a .gsm object 

 

Step 3: Creating the Parameters Script    Time Duration: 6min 06sec 

• VALUES command 

• RANGE command 

• HIDE Parameters command 

 

Step 4: Creating the 3D Script     Time Duration: 7min 

• Setting up the PEN, Material attributes 

• 3D view window to see the result 

• WALLHOLE command 

 

Step 5: Creating the Macro Call     Time Duration: 6min 23sec 

• CALL command 

• Macro object name - macro_name_string  

 

Step 6: Creating the 2D Script     Time Duration: 4 min 12sec 

• Using Global variable 

• RECT2,HOTSPOT2 Commands 
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Chapter 10- Advanced GDL scripting- Cont., Part l Opening Doors, has 4 exercise movies (Steps) 

 

Step 1: Overview        Time Duration: 2 min 48sec 

• Creating a short animation 

 

Step 2: Creating the parameters      Time Duration: 2 min 07sec 

• Defining opening angle parameter 

• IF NOT<cond> THEN<cond> Else <cond> 

 

Step 3: Creating the 3D script      Time Duration: 3 min 19sec 

• Explanation of how the commands work to show the door opening angles 

 

Step 4: Creating the animation     Time Duration: 3 min 35sec 

• Setting up Frame values 

• Create Fly through -Quick time movie 

 

Chapter 10- Advanced GDL scripting- Cont., Part ll Construction Simulation, has 5 movies (Steps) 

 

Step 5: Bringing in data from Google Earth    Time Duration: 6min 35sec 

• Saving image from Google Earth as .jpeg 

• Bringing 3D building data from Google Earth  

• Create Fly through -Quick time movie 

 

Step 6: Creating the Object from the Mass    Time Duration: 2min 18sec 

• Save 3D model as .gsm object 

 

Step 7: Creating the parameters     Time Duration: 1min 17sec 

• Setting up the parameter list 

 

Step 8: Creating the 3D script     Time Duration: 6min 19sec 

• CUTPLANE command 

• IF NOT<cond> THEN<cond> ENDIF  

 

Step 9: Creating the 3D animation     Time Duration: 1min 26sec 

• Setting up Frame values 

• Creating Fly Though 

 

Congratulations on successful completion of Building Object Creation ITG!! 


